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CoverageMaster winAMS Tutorial 

At this time we wish to thank you for your interest in GAIO TECHNOLOGYôs unit testing tool, 
CoverageMaster winAMS. CoverageMaster winAMS is a unit testing tool for evaluating and 
improving embedded software. 
 
This tutorial includes practice exercises designed for first time users. By following this tutorial and 
completing the exercises, the user will gain an understanding of CoverageMaster winAMSôs 
basic usage and features. 

 

 
 
 
 

Before starting the exercises, first an explanation of CoverageMaster winAMSôs features and 
operation will be presented. 

 

CoverageMaster winAMS is a unit testing tool for embedded software. It performs testing by 
executing the software code (functions) using an MPU simulator (System Simulator). 
 
The MPU simulator (System Simulator) operates by running the actual cross-compiled MPU code 
(object code). Because the actual target code is used in the simulation, it is possible to verify the 
programôs behavior and also check for errors that depend on the target microprocessor. 
 

CoverageMaster winAMS includes the following components: 
 

SSTManager: The primary UI application used to manage the unit testing operations. 
System-G/SX: MPU Simulator (System Simulator) ï includes support for a variety of MPUs. 
WinAMS: the unit test simulator. 

 
In addition to these programs a cross compiler or Integrated Development Environment (IDE) will 
be required to prepare the source files for testing. 

  

 
Introduction 

CoverageMaster winAMS Overview 

Embedded Software Unit Test Tool 
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CoverageMaster winAMS uses CSV format files during simulations, in order to increase the unit 
testing efficiency while maintaining accuracy. 
 
Individual unit testing settings, as well as input / output (I/O) data for variables and stub functions 
are all saved in CSV files. Thus, by using CSV files it is unnecessary to include any special test 
code or input data into the target source code. 
 

The diagram below illustrates the flow of CoverageMaster winAMS unit testing. 
 

 
 

First, the cross compiled code of the target function is loaded into the MPU simulator. The code 
must be linked executable object code (unlinked intermediate object files cannot be used).  
 
Next a CSV file must be created in order to test the base() function (in the example above). 
Information about the function such as the function name, input variables, output variables, test 
conditions, and the test data (test vector) will be included in the CSV file.  

 
In the above example, test data is entered for the input variables @a, @b, @c. In addition, the 
expected value is entered for the global variable value. 
 
Expected values for output variables (such as value in the above example) may be entered to 
compare with the actual results. The expected value cells however may be left blank if you simply 
wish to output the results. 
 
If expected values are entered, the actual test results will be compared with the expected values 
and reported as NG or OK in the test result column. If the expected results differ from the actual 
results, both values will be displayed in the cell. In the above example line 4 of the test result 
CSV reported a result of NG and 16?(10) in the value column. In this case, the 16 represents the 
actual result, and the 10 represents the expected value.  

 
 

By simply creating a CSV test data file the rest of the test simulation process is automated. 
Simply click the Start Simulator button and the simulation for the input test data will be run. 
Upon completion, the C0/C1 Coverage (*) and test results will be output. The coverage results 
may be viewed anytime from the Coverage screen or output to a file. 

(*): C1 Coverage requires the use of GAIOôs ñCasePlayer2ò static analysis program. 

CSV Format Files for Test I/O 

Automated Unit Testing with Coverage and Test Results 

Cross-compiled 
Source Code 

Test Result CSV  

Test Data C SV  

Use the embedded source code  

Auto -Test with batch processing  

 
Output Variable Name & Results  

Expected Results & Comparison  

Target Function Name  

Input Variable Name & Data  

Output Variable Name & Data  

 

MPU Simulator ( System Simulator )  base(int a, int b, int c)  
{  
    if (a == 1)  
  {  
    if (b == 1)  
    {  
      idx = 0;    // data[0]  
      if (c == 1)  
         pos = 0;   // 
data[0].str[0]  

     

     

  } 
  // Result Settings  
    value = data[idx].str[pos]; // - 
1;  
}  
 

CoverageMaster winAMS  

WinAMS  Unit Test Simulator  
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Input test data may be generated automatically for the unit test using the CasePlayer2 static 
analysis tool alongside CoverageMaster winAMS. The diagram below illustrates the simulation 
process. 

 

 

 

The following is an overview of the test data creation support functions. 
 

Automatic search for input/output variables: Automatic search for external variables that are 
referenced/assigned by the function being evaluated 

C1, Automatic test data creation to satisfy MC/DC coverage, creation support 
 

This function is explained in detail in Exercise 4 in the latter half of this tutorial. 
 

 

Coverage Master winAMS has a function (optional machine) for MC/DC coverage measurement. 
This is a function for testing the coverage of branching conditions, which is required in structural 
coverage measurement for automotive functional safety. 
To use the MC/DC measurement function, a ñMC/DC Optionò license is required. Environmental 
settings and usage are explained in a later chapter ([Application] Coverage Measurement with 
Embedded Code). 

  

Automatically Create Coverage Test Data using CasePlayer2 

About MC/DC measurement function 

C0/C1 Coverage Results View  

 

Unit Testing  

I/O CSVs  

Displays coverage path for the selected test data  

Input Data 

Cross 

Compiler  

Passes 

Info  Coverage Test Data is 

created with 

CoverageMaster  

winAMS  

Obj  

MPU Code  

(object file)  

CoverageMaster Unit 

Testing  

OMF 

Converter  

MPU Simulator  

Source 
Code  

CasePlayer2  
analyses the 

function & variables  

Test Results  

C0/C1 Coverage Report  
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In Coverage Master winAMS V3.6, ñFunction Coverage/Call Coverage Measurement Functionò 
(optional function) has been added. This function is used in the next phase of unit testing, the 
integrated test phase. It measures whether the assumed sub-functions are covered and executed 
by driving the upper level functions, not the functions themselves, but the functions in the combined 
state. 
To use this function coverage/call coverage measurement function, a ñFunction/Call Coverage 
Measurement Optionò license is required. Environmental settings and usage are explained in a 
later chapter ([Application] Function Coverage, Call Coverage Measurement). 

 

 

Coverage Master winAMS supports an optional function to perform unit tests for the C++ language, 
including tests for methods (functions) defined in C++-specific classes and tests that take into 
account the behavior of class constructors (initialization functions). 
A ñC++ Optionò license is required to use the unit test function for the C++ language. The C++ 
language is not covered in this tutorial. 

  

Function Coverage/Call Coverage Measurement Function 

Unit Testing for the C++ Language 
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The following preparations are required in advance. 

 Installation of teaching materials. 
- Copy the sample source ñwinAMS_CM1.zipò to the C drive and extract it. 

 Install a cross-compiler (development environment) for your microcontroller. 

- Separate preparation is required. (Not included in this tutorial) 
     
     

First, review the sample code used in the practice. 
The following source files (2 files) are available in the ñC:¥winAMS_CM1¥targetò folder. 

 

main.c: There are functions func1() to func5() and main() function to be evaluated. 
irq.c: There is an interrupt handler function written in C language. (Not used in practice) 

 

The source file main.c contains the functions to be tested for the practical training. There is also a 
main function in which the application code is actually written, but this sample code is an empty 
function. Coverage Master winAMS uses a microcomputer simulator (System Simulator) that 
performs instruction code execution equivalent to that of an actual microcomputer chip, so it is 
necessary to generate code that can be executed by the linker. For this reason, the main function 
is written to generate an entry for main. 

 

Please build this sample source with your separate compiler (development environment) to 
generate an executable object. This executable object file must contain ñdebugging informationò. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

      
 

   

Getting Ready 

Preparation of the practice environment 

Compiling Sample Sources 

Compiler 

Linker 

SAMP1.out 

 irq.c  

main.c 

 irq.o  

main.o 

ƴSample source files 

ƴExecutable object files 
Debugging information must be included. 
The file extension depends on the compiler. 
 
Extension (e.g.)  .out .elf .abs .ax f 

In this tutorial, the object file name is described 
as ñSAMP1.outò.. 
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The file structure of this practice environment is as follows. 
Only objects in SAUF format ñ*.xloò can be used by the Coverage Master winAMS for testing. In 
order to be used with Coverage Master winAMS, the object conversion function ñOMF conversionò 
must be used to convert the executable object files generated by the compiler into the ñ*.xloò format. 
This conversion process can be automated, so testers are not aware of it during normal testing 
operations. 
This executable object file must also contain ñdebugging informationò. This debugging information 
is essential for unit testing in Coverage Master winAMS. Other compilation options, such as 
optimizations given to the compiler, can be used without modification. 

 

Generate an executable object file (SAMP1.out) in the C:¥winAMS_CM1¥target folder. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

 

File Structure of the Practice Environment 

Compilation environment for 
evaluation source 

Static Analysis Environment 
(CasePlayer2 project) 

SAMP1.out. xlo   

Prepared directly under C drive 

Unit test environment  

 (winAMS project) 

ƴLoadable object files 
ñOMF-convertedò object files after linking 

(SAUF format *.xlo) 
Debugging information required 

Automatic conversion to SAUF format (*.xlo) with 
Coverage Master's ñOMF conversionò function 
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First, let's experience a series of testing tasks, creating a CSV file for unit testing and outputting 
the results after the test is executed. In this hands-on training, you will learn how to create a test 
input CSV file and how to check input/output test results and C0 coverage results. 

 

First, create a test project. 
 

1. Start Coverage Master winAMS by selecting Windows ñStartò -> ñGAIO winAMSò -> 
ñwinAMS(SSTManager)ò. 

2. Select ñFileò menu -> ñNew Projectò. 
 

In the dialog for creating a test project, configure as follows. 
 

3. Enter ñUnitTestò as the Project Name. (A folder with this name will be created.) 
4. Press the Browse button and select the folder, ñC:¥winAMS_CM1ò. (The UnitTest 

folder will be saved in this location.) 
5. Under Simulator Engine, select ñStandard (System-G)ò or ñHigh Speed (SX)ò. 
6. Select a microcontroller name for MPU. 
7. Select a compiler name for Compiler. 
8. The ñOthersò setting varies depending on the selected microcontroller/compiler. 

For details, refer to the Windows menu ñGAIO winAMSò -> ñMPU Setting Manualò and 
refer to the relevant microcontroller/compiler setting information. 

9. Leave the CasePlayer2 project blank. (This will be used in Exercise 4.) 
 

This creates the "C:¥winAMS_CM1" folder, which contains the UnitTest folder for storing test-
related data, and opens the test project. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Exercise 1: Our First Test (Intro) 

About the Issue 

Create a new test project 

Others 

 

Ŷ Set the project name. 
Ŷ A folder with ñproject nameò will be created 
   (Select ñC:¥winAMS_CM1ò) 
 

 

Ŷ Select microcontroller name 
 

Ŷ Select simulator engine 
Ŷ Select compiler name  

(C++ language included is OFF) 
 

 

 

ŶSettings vary depending on the selected 
 microcontroller and compiler.. 

 
 

 

 

 

 Ŷ Leave blank for Exercise 1-3 

(Used in Exercise 4 to use the test data 
creation support function.) 
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OMF Conversion Settings 

Once the project is opened, make the necessary settings. First, perform an ñOMF conversionò to 
convert the executable object file (*.out) generated by the compiler to the ñ*.xloò format. 

 

1. Press the Converter Settings button at the top of the left column. 
2. Set the compiler-generated execution object file ñC:¥winAMS_CM1¥target¥SAMP1.outò 

to the second line Input Object from the top of the setting item. 
3. Check the Convert Automatically checkbox at the bottom of the settings item. (This is 

checked by default.) By checking this checkbox, OMF conversion will be automatically 
performed every time the executable object file is updated thereafter.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Next, perform OMF conversion. 
 

4. Press the OMF Convert button at the top. 
-  The result of the conversion is displayed in the message view at the bottom. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

Starting to convert.  
 
  Initialization... 
 
  Converting Header Information... 
 
  Converting Unit Information........ 
 
  Converting Section Information........ 
 
  Converting Debug Information.... 
 
  Ending Process... 
 
  Complete to convert OMF. Output number of debug file(5) number of debug 
symbol(141) 
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Once the project is opened, the first step is to add the settings for using Microsoft EXCEL (*EXCEL 
must be installed on the PC to be used) for CSV creation. ) to create the CSV. 
 

1. Press the ñOther Settingsò button in the left column. 
2. Confirm that the second line from the top of the setting item ñOpen CSV test result file 

with external editorò is checked. (If it is not checked, check it.) 
 
 
 
 
 

     

Set up the test target. First, specify ñSAMP1.out.xlo,ò an OMF conversion of the object file compiled 
and created in the previous section.This file contains debugging information, including variable 
symbol names for setting test contents, source file paths, and correspondence information 
between source code lines and execution code (line information). Only one file, this .xlo file, is 
designated for testing. 

 

1. Press the ñStartup Settingsò button, the second button from the top in the left line. 
2. Confirm that ñC:¥winAMS_CM1¥target¥SAMP1.out.xloò is registered in the target 

object file. 
 

Next, check that the ñstartup command file,ò a file for configuring the microcomputer simulator 
environment, is set. The startup command file is a command (script) file that is executed when the 
microcomputer simulator (System Simulator) is started, and is useful for starting the test 
environment with the same settings each time. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Other settings (for using EXCEL as CSV editor) 

Specify test target and startup settings 

Object file after OMF conversion 

Startup command file 
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The startup command file is a script file loaded when the MPU simulator starts. It is used to change 
the MPU simulator configuration for unit tests. For example: 
 

 ̧ Change memory attributes (ROM -> RAM) 
 ̧ Skip unnecessary loops that wait for hardware or peripheral signals 
 ̧ Change local variables while executing a target function 
 ̧ Initialize a large memory area before starting unit tests 

 

The startup command file contains the following. When the microcomputer simulator is started, all 
commands are executed in order from the top. Click the ñEditò button on the right to review the 
contents in Notepad. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The first three lines are the basic commands required to use the microcontroller simulator for unit 
tests. The file created by default contains only these three lines. 
 

If you do not need to change microcontroller settings or operating conditions, you can test only 
with default commands. A simulation error occurs if an operation that violates a memory attribute 
occurs during the simulation run. 

 
 
 
 
 
 
 
 
 
 
 

 

Startup Command File 

System Simulator  
xlo 

txt  

Test Target  

Object File  

Startup  

Command File 

 

 

 

 

 

 

 

 

 

 

 

start log/all  

on error then continue  

set unit/all  

 

Default Commands 
 

Added commands by user 

 

 
 

Open in Notepad 
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In this reference section the CoverageMaster winAMS unit test flow will be described. 
 

CoverageMaster winAMS uses an embedded MPU simulator (System Simulator) to execute the 
functions coded for the target device. The MPU simulator is designed so that it will perform the 
same as if tested on an MPU evaluation board. 

 
Normally when the MPU system powers up the hardware is reset, the program counter (PC) is 
set to the reset vector (start address), and then the operation begins. The MPUôs initial program, 
called the startup routine, is found at the start of the program. When executed the startup routine 
initializes the stack pointer, initializes the MPU register, and makes other necessary settings for 
operation. 

 
For a standard MPU system, the main() function is then called after the startup routine has been 
completed. When performing unit tests with CoverageMaster winAMS, the program counter is 
instead altered by the simulator to execute the target function. 

 
The Specify Startup Routine End Address setting in the Test Settings specifies where to start 
after the startup routine has ended. Normally this is set to main(), however it may be changed to 
a different address if necessary.  

 

 
 

In order to start the startup routine when launching the MPU simulator, the reset address value 
should be specified to PC (program counter). The ó@resetô command described in the startup 
command file will set the MPUôs reset address value to PC automatically. However, the address 
may not be set correctly depending on the MPU type. In this case, the ñset reg pcò command can 
be used to set the reset address value. 
 

set reg pc = 0x********  
 
Refer to the MPU hardware manual regarding the MPU reset address value. 
 

 

 

(Ref) Unit Test Flow 
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Now letôs begin practice Exercise 1. The goal of Exercise 1 is to create test data that will achieve 
100% C0 coverage for func1() included in the sample code. 
 
Below is a copy of the sample code for func1(). It may also be viewed by opening main.c in the 
development environment. 

 

 
 

First letôs confirm the input / output conditions. The variables in red (above) are the input, giving 
us three input variables. There is no return value for this function; the results are stored in the 
global structure gb_result.  

 
Therefore, practice Exercise 1ôs test conditions include three input variables (enable, mode, 
input) and two output variables (gb_result.data, gb_result.ret_code) included in the global 
structure. We will use this information to create the CSV file.  
 

Now we will create the CSV file for testing func1(). 
 

1. Click the Create CSV button in the upper portion of the SSTManager window. 
2. Select Unit Test CSV and click the OK button. 

 

 
 
 
 
 

The Unit Test CSV Settings dialog will now appear. 
  

Creation of CSV file template for module testing 

// Global variables  

struct ST_PARAM  

{  

    int data;  

    int ret_code;  

} gb_result;  

 

void func1( int enable , int mode, int input  )  

{  

    if( enable  )  

   {  

        switch( mode )  

        {  

        case 0:  

            gb_result.data  = input  ;  

            break;  

        case 1:  

            gb_result.data  = input  * 10;  

            break;  

        case 2:  

            gb_result.data  = input  * 100;  

            break;  

        case 3:  

            if( input  >100 )  

                gb_result.data  = 10000;  

            else  

                gb_result.data  = input  *100;  

            break;  

        default:  

            gb_result.data  = - 1;  

        }  

        // return code  

        gb_result.ret_code  = TRUE;  

    }  

    else  

    {  

        gb_result.data  = 0;  

        gb_result.ret_code  = FALSE;  

    }  

}  
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From this Unit Test CSV Settings dialog, we will enter the test conditions.  
 

3. Enter func1_data as the filename. 
 
This will become the name of the CSV file with a .csv extension. The filename may be anything 
you wish, but since in most cases a CSV file is created for each function, including the function 
name helps keeps them organized. 

 
Next select the target function to be tested: 
 

4. Next to the Function box click the é button to open a selection dialog, select func1 by 
expanding the f tree and clicking on func1, then click OK. 

 
The selection dialog includes a list of functions whose debug information is found in the 
SAMP1.xlo object file we included previously. Function names may also be typed in directly 
instead of by using the selection dialog. 
 

5. Input func1 unit test into the Test Description box.  
 
This setting is optional. However, by giving the test a simple descriptive it makes it easier to 
differentiate this CSV file from others. The test description will appear in the CSV file list and 
results report. 
 
Next select the INPUT variables: 
 

6. From the All Variables tab of the variable list view, expand the Function Parameter 

\

\  
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folder. (three function parameters for func1 will be shown) 
7. Select Enable, Mode, and Input from the variable list, then add them to the INPUT list 

by clicking the Add (I)-> button located next to the INPUT list. 
 

Function Parameters appear as function_name@variable_name in the variable list.  
Lastly, select the OUTPUT variables: 

 
8. Expand the g folder in the variable list to display the variables starting with the letter ógô. 
9. Expand the gb_result tree, then add gb_result.data and gb_result.ret_code to the 

OUTPUT list by selecting them and clicking the Add (O)-> button near the OUTPUT list. 
10. Click OK. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note: When adding variables from the variable list, you may select and add multiple variables at 
a time by using the SHIFT or Ctrl key to make a multiple selection. 
 
Youôve now created the func1_data.csv file to be used in Exercise 1.  
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The generated CSV file (template) for module testing will be displayed in the ñCSV Listò in the 
ñTest Settingsò. Let's check it out. 

 
1. Press the ñTest Settingsò button on the left of the window to switch screens. 
2. Double-click ñfunc1_data.csvò in the ñCSV Listò to launch Excel. 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Check the generated ñCSV fileò with EXCEL. What is created is the part of test conditions such 
as selected function name and input/output variable name. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Because this file is a CSV file in comma-separated text format, EXCEL or a general text editor can be used, 
but once the CSV file has been generated, if you wish to add or remove variable settings, do not edit the CSV 
file directly, but return to the ñUnit Test CSV Settingsò dialog and redo the variable selection. Even after test 
data has already been entered, variables can be added without losing any data. 

 

To return to the ñUnit Test CSV Settingsò dialog again, press the ñEdit I/O...ò button to the right of 
the "Class Test CSV List". 

 
 
 
 
 
 
 
 
 
 
 
 
 

Check the Unit Test CSV File You Created 

For module testing. 

Function name 
to be tested Test title (optional) 

Number of input 
variables 

Number of output 
variables 

Input variable 
names (there are 3) 

Output variable 
name (there are 2) 
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Although not used in this practice, the ñ#COMMENTò field in the CSV file will be explained. 
The cells in this column are used to invalidate (exclude from test data) the entered test data row. 
Entering a ñ;ò (half-width semicolon) in this cell will disable the data in that row. It can be used to 
temporarily exclude data. 
 
It can also be used in actual operation to comment and describe the meaning of test data. If you 
put a semicolon in the #COMMENT field, you can describe anything on that line. 

       
 
 
 
 
 
 
 
 
 
 
 
 

Let's add test data for testing func1() to this ñCSV fileò template for module testing. First, let's run 
Coverage Master winAMS to experience what kind of test results will be output. Use EXCEL to add 
test cases. One row of CSV corresponds to one test execution of a function, so we create test data 
for 5 executions of func1(). 

 

3. Add the test data to the INPUT variable in lines 3-7 in the figure below. (5 test cases) 
4. The ñexpected valueò can be entered as a member of the gb_result structure, but this 

time we leave it blank. The input of expected values will be discussed later in the 
section on retesting func1() to achieve 100% coverage. 

5. Save this CSV file ñfunc1_dataò by overwriting it from the EXCEL File menu. 

6. Close EXCEL. If you leave a CSV file open in EXCEL, you will not be able to open this 
CSV file from other applications such as Coverage Master winAMS because the file is 
still open. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

Add test data to ñCSV Fileò for module testing 

(You can freely write comments here.)  

Enter here Where to enter expected values 
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Let's perform a unit test run of func1() with the created CSV file. Before doing so, check the setting 
items listed below (1-5). If the items are not set, set them. 

 

1. Check the check box to the left of ñfunc1_data.csvò in CSV List. 
2. Check the checkboxes (3 locations) in the Coverage Settings column in the figure 

below. 
3. Set Initialization End Address to ñmainò + ñ0x0ò. 
4. Check the Output Execution Time in the Other Settings column. 
5. Check the Treat óNo Checkô as óOKô in the Other Settings column. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The ñOutput Execution Timeò function in the ñOther Settingsò column is not a required setting. 
This function outputs the time taken by the microcontroller to process test data for each test data. 
The measured time is written to an output CSV file. 

 

However, this measurement time is converted based on the cumulative number of cycles (clocks) 
executed per instruction executed. Operation times such as read/write time to memory, pipeline 
processing, and cache execution that occur in actual microcontroller hardware are not taken into 
account. Therefore, the time measured here does not exactly match the actual execution time on 
the microcontroller chip. 

 

The number of microcontroller clocks for time conversion can be changed in ñMPU Clockò in the 
ñTarget Settingsò view. For this practice, assume that the microcontroller used is ñ100 MHzò and 
set the value to ñ100ò. 

 
 
 
 
 
 

Now, let's start the microcontroller simulator (System Simulator) and the unit test simulator 
(WinAMS) and run the tests. 
 

Test execution of func1() 

1 

2 

3 

4 

5 
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6. Press the ñStart Simulatorò button at the top of the window. 
7. The microcomputer simulator (System Simulator) starts up. 
8. Make the ñWinAMSò window smaller and place it in a corner of the desktop (this 

window is not used). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9. Select ñOptions...ò from the ñToolò menu of the microcontroller simulator screen. 
10. Check the checkboxes (3 locations) for the tracing items on the ñOptionsò screen (see 

below). With this setting, the execution point of the source code (the line displayed in 
yellow in the source code window) is traced. 

11. Press the ñApplyò button to close the options screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
  

System Simulator 

Make the window smaller 
and put it in the corner 
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12. Select ñGoò from the ñExecutionò menu in the microcontroller simulator (System 
Simulator). Microcontroller Simulator (System Simulator) source code tracing begins. 
The trace position indicates the point where the test is currently being executed. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The ñtrace modeò used here updates the source code screen according to the execution line, which 
slows down the execution speed. This trace mode is not used in normal testing. From now on, this 
trace mode will be used with this trace mode turned off. (Ÿ See ñfunc1() retest to make coverage 
100%ò) 

 
When ñCompleted the test.ò is displayed, the test is finished. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
  

Running Row Running screen 

Show executed rows 

It will be displayed when the test is completed 
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13. Select ñExitò from the ñFileò menu of the microcomputer simulator (System Simulator).  
 
 

When the microcomputer simulator (System Simulator) is finished, a test result CSV file is created 
in the ñTest Resultsò window of SSTManager. The file name is the same as the CSV for input, but 
it is generated in a different folder from the CSV for input. 
 

First, check the test results. 
 

1. Double-click the test result ñfunc1_data.csvò. EXCEL is launched and the test results 
are displayed. 

 

 
 
 
 
 
 
 
 

The test results (output file) are in the same format as the CSV file for module testing (input file). 
Input data given to the 3 arguments are copied and output as is. The data output to the structure 
members ñgb_result.dataò and ñgb_result.ret_codeò is the result of the execution. Since no 
expected value is set for the input data, the judgment column in column 7 (column G) will display 
ñNO Checkò. (If you set the expected value, OK/NG will be output according to that pass/fail.) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The destination of this test result CSV file can be specified in ñTest Results Folderò under ñTest 
Settingsò. By default, the folder name with the timestamp of the project creation is applied. 

 
 
 
 
 
 
 
 
  

Check func1() input/output test results 

Created test result CSV file 

Input data is copied as is. Execution Result 
Meaning ñnot 

checkedò because no 
expectations are set. 

Estimated execution 
time (approximate) 
Converted by set 
clock frequency 
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Next, check the results for C0 coverage. The output data checked in the test result CSV file is also 
referenced in the coverage results, so it is necessary to close the CSV file opened in EXCEL. 

 
1. Close the output CSV file (func1_data.csv) opened in EXCEL 
2. Press the ñCoverageò button on the left. 
3. C0 coverage rate ñ88%ò can be confirmed. 

 

 
 
 

4. Double-click on func1 in the function list to display the Coverage Viewer. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

This is a portion of the C0 coverage result of func1(). As the legend at the top of the screen 
shows, the yellow highlighted code indicates code not executed, red indicates code that was 
executed by all test data sets, and green indicates code that was executed by at least one test 
data set. The number appearing to the right of the row number indicates the number of times the 
line of code was executed. 
 
Next weôre going to display the coverage view alongside the test data sets. 

 
5. At the upper right portion of the Coverage View window change the selection from All 

Tests to func1_data.csv. 
6. This will cause the test result CSV file to appear in the upper portion of the Coverage 

View window (if not visible try adjusting the window size or by scrolling). 
 

Check the Coverage for func1() 
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Try clicking on one of the test data rows. Once selected the test data row will become 
highlighted, and the coverage path for that data set will be shown in red in the coverage display. 
If a comment row or name row is selected the coverage for the entire test set will be displayed.  

 
In addition, it is possible to highlight the test data that passes through a selected line of code. 

 
7. Click anywhere other than the number (e.g., NAME) to return to the overall coverage 

view. 

8. Right-clickò on the line of if( input > 100 )  in figure óaô above. 

9. Select ñMake Data Rows Passing Here. 
10. A red mark appears on the 5th data. 

 

 
 

This means that test data line 5 is the only set of test data that passes through the selected if 
statement. 

 

Looking at line #50 of the code weôll notice it is highlighted in yellow meaning it was not executed. 
Therefore, we need to come up with a value to insert into the test data so that this row will be 
executed. Using test data row 5 as our base (since it passed through the if statement), we simply 
need to enter a value greater than 100 into the input variable to make the if statement true.  

click 

a 

right click 
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The above are simple examples of analyzing features available from the coverage results. For 
unit testing with more complex source code (such as multiple nested condition statements), these 
analyzing features become even more useful for determining what test data to enter. 

 
 

CoverageMaster winAMS executes the actual MPU code in order to perform unit testing and 
coverage testing. This section will explain the correlation between the MPU code and the 
coverage results. 

 
1. Click the Show disassembled code button found in the upper portion of the coverage 

view. 
2. The disassembled code (the MPU code) will be displayed in the coverage view. 

 
The disassembled code comes from the debug information generated by the compiler. It is the 
same as a C / assembly ñmixed displayò of ICE debuggers and MPU simulators.  

 
CoverageMaster winAMS displays the coverage by highlighting the C code that corresponds to 
the execution code (MPU code). When using compiler optimization features, the compiler may 
modify (optimize) the execution code in order to increase the execution speed. This may 
adversely affect the coverage results display. 

 
Using the code below as an example, youôll notice the variable int i is declared at the beginning 
of the function. However, since the variable i is not used in the function, it was removed due to 
compiler optimizations. In this case int i will simply be left blank and not receive coverage as 
shown below. 

 
 

 
 

Like in the example above, it may be useful to show the disassembled code for unmarked lines 
when viewing the coverage results. 

 

The Relationship between the Code and the Coverage 
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Now letôs open the coverage test report file. 
 

1. Click the Test Results button on the left side of SSTManager. 
2. Click the Open Reports button on the upper right part of the window. 
3. The test report will be opened with your web browser as shown below. 

 

 
This HTML file contains a variety of information regarding the most recently performed test. 
These test report files are not intended for archival storage, rather temporarily stored for viewing 
the results of the most recent test. 
 
The test report includes the following information: 

 
Entire Information: The top CSV File, links to the input CSV files. 
Test Report: CSV Files, links to the output CSV files. 
Coverage Report: the tested functions and their coverage rate, links to the coverage log files. 

 
An example of a coverage log text file is shown below. The log files may be output in either text 
or HTML format (configured from the Test Settings window). 

 

Open the Test Report File 



 

 
CoverageMaster winAMS Tutorial 

 

 
 

-  29  -  
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The goal of Exercise 1 is to achieve 100% C0 coverage. So we will add the missing data and retest. 
It also sets the expected value and checks the result of the expected value determination. 

 
1. Switch screens with the ñTest Settingsò button and open the input CSV file 

ñfunc1_data.csvò. 
2. Add 2 times test data (red solid line). 
3. Add the expected values (red dashed line). Some data are intentionally set to different 

values. 
 

The expected values enclosed by the red dashed line have been entered with values that differ 
from the results of the run (cells with expected value = 99, in 2 places). We would like to see how 
the different results from the expected values are reported after the run. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

4. Save the CSV file using ñSaveò from the ñFileò menu in EXCEL. 
5. Close EXCEL. 

 

Now, we will retest. In the previous test run, after pressing the ñStart Simulatorò button, the test run 
was performed by manually operating the microcomputer simulator that was started, but this part 
will be automated. (Auto run mode) 

 
6. Switch to the ñTarget Settingsò screen from the left button. 
7. Enable both ñStart Automaticallyò and ñQuit Automaticallyò checkboxes in the 

ñSimulator Optionsò section. 
 

 
 
 

Retest func1(), get 100% Coverage 

Cell [99] contains the results of 
the run and the different expected 
value from the result of the run. 
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This option switches between automatic execution and a mode using the debugger UI. When this 
option is turned on, simply pressing the ñStart Simulatorò button from the Coverage Master winAMS 
enables test execution without having to operate the microcomputer simulator.  
 
Start the test. 

 
8. Click the Start Simulator button on the upper portion of SSTManager. 
9. The test will be performed automatically and then display the test results window. 

 
Since we turned off trace mode the simulation should completely quickly. Now letôs check the 
test results and coverage.  

 
10. Double-click ñfunc1_data.csvò in the ñTest Resultsò view to open it. 

 
When output results differ from the expected values they will be displayed as 
ñactual_result?(expected_result)ò as shown in the image below. The test result will display ñNGò if 
the actual/expected values differ, ñOKò if they are the same, and ñNO Checkò if no expected 
values were entered. 

 
 

 
 
 
 
 
 
 
 
 
 
 

Also check the coverage results which should now be 100% for C0 coverage. 
 

 

As mentioned before, the MPU simulator window is not displayed when using the automatic 
execution mode. If the MPU simulator running in the background does not close automatically due 
to an error or an infinite loop, the simulator can be accessed by performing the following operations: 
 

1. Click the ñLò icon on the Windows task tray. 
2. Select Display from the pop-up menu. 
3. Select File -> Quit in the LiX window to quit. 

 
 

 

This is a review of the unit test execution flow and test results output location. The unit test 
execution flow is as follows: 
 

1. Start a unit test by pressing the Start Simulator button from SSTManager. 
2. The MPU simulator (window name: SystemSimulator) starts up. 
3. Unit test simulator (window name: WinAMS) starts up. 
4. MPU simulator starts unit test execution. 

- When using automatic mode: (Automatically starts) 
- When using manual mode: Select Execution -> Go 

5. The test cases are loaded and the target function is executed. 

(Ref) To display the MPU simulator running in the background 

(Ref) Application Module Structure and Result File Location 
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6. The test results are output to a CSV file. 
7. The coverage report file (txt/html) is created. 

 
8. Quit the MPU simulator. 

- When using automatic mode: (Automatically quits) 
- When using manual mode: Select File -> Exit 

9. The test results can be viewed from SSTManager. 
 

 
 

The input/output file location is as follows: 
 

 ̧ Input CSV File: [Test project folder]¥TestCSV 
 ̧ Result CSV File: [Test project folder]¥Out[Creation Date][Creation Time] 
 ̧ Coverage Report: [Test project folder]¥Out[Creation Date][Creation 

Time]¥TestCoverLog 

 
 

 

Weôve now completed our first test with CoverageMaster winAMS. In this exercise we learned the 
fundamentals of using CoverageMaster winAMS such as creating CSV files, inputting test data, 
running the simulation, and viewing the test results / coverage. 

  

Exercise 1 Conclusion 
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For our next practice exercise, we will simulate a function that includes pointers. 
 

Pointers are often used to hold an address for an object that resides outside of the function. Also 
pointers are commonly used to hold the address of a data table (array) used throughout the entire 
application. However, when unit testing functions it is more efficient to input data directly to the 
function rather than using a data table. 

 
For this exercise we will use CoverageMaster winAMSôs Automatic Allocation feature for pointers, 
and then input the necessary test data.  

 
 

For this exercise we will be testing func2() located in the sample file main.c. This function uses 
pointers frequently, but before worrying about that first letôs identify the input and output variables.  

 

 
The following three variables are referenced in the function:  
 

char *gb_port1 (global pointer variable), 
int mode (function parameter), int *data_in (function parameter) 

 
Two out of the three are pointers that point to individual variables. 
 
For the output the following variable is used to hold the result:  
 

int *gb_data_out (global pointer variable) 
 
Now we can use this information in the CSV file creation. 
 

  

Exercise 2: Unit Testing a Function with Pointers 

func2() Sample Code 

char *gb_port1;    // i/o port input  

int  *gb_data_out; // result  

 

/*  

(Exercise 2) Function Sample with Pointer Variable  

"mode"     : Operation mode  

"*data_in" : Input data  

return value : "*data_out"  

*/  

void func2( int mode, int *data_in )  

{  

if( *gb_port1 & 0x00000001 ) // When the least sign  

{  

switch( mode )  

{  

 case 0:  

   *gb_data_out = *data_in;  

   reak;  

 case 1:  

   *gb_data_out = *data_in * 10;  

   break;  

 case 2:  

   *gb_data_out = *data_in * 100;  

   break;  

 case 3:  

   if( *data_in > 100 )  

      *gb_data_out = 10000;  

else  

*gb_data_out = *data_in*100;  

      break;  

    default:  

        *gb_data_out = - 1;  

 }  

}  

else  

{  

gb_data_out = 0;  

}  

}  
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As an example, the following settings are required to use the pointer variable ñchar *gb_port1ò: 
 

Step1: Set the address value to the pointer variable gb_port1. 
Step2: Set test cases to the memory referred by gb_port1. 

 

The address value may be given before func2() is called when the actual application is executed, 
however it must be specified by the user before executing the func2() unit test. There are two 
methods to give an address value to a pointer when using CoverageMaster winAMS. 
  

In order to directly set an address value to a pointer, specify the pointer name in the CSV file as 
an input variable. In case of ñchar *gb_port1ò, enter ñgb_port1ò in the CSV cell, and enter the 
address value in hexadecimal (begin with ñ0xò) as the test case value. 
 
When using this method, the user must manage the address allocation according to the MPUôs 
memory map. If the MPU type or memory map changes, the address value may need to be 
changed. After setting the pointer address, enter the pointer entity ñgb_port1[0]ò to the next cell to 
enter test cases.  

 

 
 

CoverageMaster winAMS has an automatic pointer allocation feature for executing unit tests. This 
can be an easier method because the user does not need to manage the address value assigned 
to the pointer manually. 
 
In order to automatically allocate memory to a pointer, add ó$ô in front of the pointer name when 
entering it in the CSV cell. In case of ñchar *gb_port1ò, enter ñ$gb_port1ò in the CSV cell, and 
then enter the number of objects to allocate area for as the value. If the pointer is an arrayôs start 
address, the number of array items should be entered for the number of objects. If zero is entered, 
the pointer will be NULL. After setting the pointer address, enter the pointer entity ñgb_port1[0]ò 
to the next cell to enter test cases.  
 

 

 
 
  

Address Values and Test Cases Required for Pointer Variables 

Set address value to the pointer directly 

Use the automatic allocation feature 

Step1: Specify pointer 
variables directly Step2: Specify entity by subscript 

Step2: Specify the entity with subscripts 

Step1: $ mark Ÿ area assignment 
(There is a function to automatically 
assign the pointer to the simulator) 
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Now letôs create the CSV file for Exercise 2 using the same method we learned in Exercise 1.  
 

1. Click the Create CSV button towards the top of SSTManager. 
2. Select Unit Test CSV and click OK. 
3. In the Unit Test CSV Creation dialog enter func2_data for the filename. 
4. Select func2 as the function. 
 
 
 
 
 
 
 
 
 
 

 
First add char *gb_port1 to the INPUT list. Since this is a pointer we must also allocate memory 
for it. 

 
5. Expand g in the variable list, then select gb_port1. 
6. Click the INPUT listôs Add (I) -> button. 

- The Pointer Settings dialog opens. 
     

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Using char *gb_port1 as our example each setting functions as follows: 
 

 ̧ Address: Use this setting when specifying an address to the pointer variable (gb_port1 
will be added). 

 ̧ Allocate memory: Use this setting when you wish to allocate memory for the pointer 
($gb_port1 will be added).  

 ̧ Number / Character: Use this setting when the pointer points to an array and you wish 
to enter the entire array data into a cell. (*gb_port1 will be added). 

 ̧ Pointer with index: Use this setting when you want to specify objects pointed to by the 
pointer (gb_port1[0],é, will be added).  

Create a CSV File with Pointer Auto Allocation 

Selection 
Pointer Variable 
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Allocate Memory and add gb_port1 as Pointer with Index options. 

 
7. Check both Allocate Memory and Pointer with Index (leave the index at 0 to 0), click 

OK. 
8. $gb_port1 and gb_port1[0] will be added to the INPUT list. 

 
Next add the other input variables in a similar manner.  

 
 ̧ @mode (function parameter): since it is of type int, it may be added to the INPUT list by 

simply selecting it and clicking the INPUT listôs Add (I) -> button. 
 ̧ @data_in (function parameter): since it is a pointer, add with Allocate Memory and 

Pointer with Index (leave the index at 0 to 0) settings (same as gb_port1 above). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Next weôre going to add our output int *gb_data_out to the OUTPUT list. But since this variable is 
a pointer we must first allocate memory for it in the INPUT list. 

 
9. Expand g in the variable list, then select gb_data_out. 
10. Click the INPUT listôs Add (I) -> button. 
11. Check Allocate Memory and click OK. 

  

Set 

Set 
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Now weôre going to add gb_data_out to the OUTPUT list so we can check the results and give it 
expected values. 

 
12. Expand g in the variable list, then select gb_data_out. 
13. Click the OUTPUT listôs Add (O) -> button. 
14. Check Pointer with Index (leave the index at 0 to 0) and click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Now that weôve completed the I/O variable settings click OK to create the CSV file. 
Next weôre going to enter test data.  

 
 
 
 
 
 

15. Go to the ñTest Settingsò window of SSTManager. 
16. Double-click on the ñfunc2_data.csvò line to open EXCEL and set the test data. 

 

Set 

Set 
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Because the pointers used in func2() are pointers to individual objects (as opposed to arrays), a 
ó1ó should be entered for the columns that begin with a dollar ó $ ó sign. These columns indicate the 
number of objects to allocate memory for, in func2()ôs case only 1 is needed. 

 

The data enclosed by the green box is the expected value of ñgb_data_out[0]ò to be evaluated. All 
are correct expectations. 

 
 
 

Weôre now ready to test func2() using CoverageMaster winAMSôs pointer memory auto allocation 
feature. 
 
On the Test Settings screen, check the Run box next to ñfunc2_data.csvò (uncheck all other 
files). The check box for ñfunc1_data.csvò should be OFF. 
 

1. In the Pointer Area Allocation Settings section, check the Set Area box. 
 

Specify the address for automatic allocation. Since Coverage Master winAMS is executed using 
a microcomputer simulator, the memory area to be allocated also uses the address area of the 
actual microcomputer. Specify an unused area (an area to which no code/variables/stacks, 
peripherals, etc. are assigned) of the microcontroller to be used as the area for automatic 
allocation. 
 

2. Specify unused area addresses Start Address (0x...) to End Address (0x...) in Set 
Area. 

 
 

This will create a pointer variable entity in the specified area that will be allocated with ñ$ò. However, 
the tool automatically determines which address within this area will be assigned when the test is 
executed. 

 
 
 
 
 

Unit Testing using the Pointer Memory Auto Allocation Feature 

expected value 

Variables with $ 
Number of entities 



 

 
CoverageMaster winAMS Tutorial 

 

 
 

-  39  -  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Now letôs start the test. The procedure is the same as in Exercise 1. 
 

3. Press the Start Simulator button at the top of SSTManager. 
 
 
 
 

Once the simulation has been completed, the Test Results screen will be displayed. 
 

 
 
 

4. Double-click on func2_data.csv to view the test results. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
Since the correct expected values were entered the results should all appear as OK. 

 
This concludes Exercise 2: unit testing with pointers. 
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This section explains how to input data for an array into the CSV file. For a character array (string) 
the variable name begins with an asterisk ó * ó if declared as a pointer, and an ampersand ó & ó if 
declared as an array. Such character arrays (strings) may be entered by selecting the Number / 
Character option in the Pointer Settings selection dialog shown in Exercise 2. 

 
Character array (string) data must be enclosed within single-quotation marks ( ó ). 
 Example: óabcdefgô  

 

 
 

For number arrays, each value should be separated by a ó | ó mark as shown in the image below. 
 

 
 
 

  

(Ref) How to Input Array Data into the CSV File 

/*  

   Character Array Data  

*/  

char outStr[64];  

 

void StringTest( int 

limit )  

{  

        outStr[limit] = 

' ¥0';  

}  

int ArrayTable[10];  

 

void ArrayTest( int 

index )  

{  

  int i;  

  if( index>10 ) 

index=10;  

    for( i=0; i<index; 

i++ )  

      {  

          ArrayTable[i] = 

0;  



 

 
CoverageMaster winAMS Tutorial 

 

 
 

-  41  -  

In our next exercise weôre going to test a function that includes a call to another function. 
 

Many functions include calls to other functions to perform various tasks. For example, say we have 
a function named func() that calls another function named sub() as represented visually below. 

 
 

In the example above, the result of function func() is dependent upon the data return by the called 
function sub(). Therefore, if you wish to test func() as is, you will first have to find the appropriate 
input conditions for sub() in order to obtain the desired return value to be used in func(). In addition, 
because the two functions are dependent upon one another, both functions would need to be re-
tested whenever either one changes. This is too complex and inefficient of a method. 
 
In such cases when called functions exist, a stub function may be configured and used instead of 
the actual called function. In the example above, the function STUB() takes places of the function 
sub() allowing us to control the return value and focus on testing one function at a time. 

 

CoverageMaster winAMS includes features for using stub functions, including: 
 

 ̧ Creating stub functions, and configuring them to interface with the test function. 
 ̧ Replacing the called function with the stub function during testing. 

 
The ability to substitute called functions with stub functions is an important feature in 
CoverageMaster winAMS. Using this feature the stub function may be called without having to 
modify the source code of the test function or the functions called by it. 
 
Stub functions created with CoverageMaster winAMS will be contained in one source file. Because 
the stub function will be executed by the MPU simulator, it is necessary for the stub function to be 
compiled and linked. 

 
Now letôs begin the exercise and learn how to create and configure stub functions.  
 
 

  

Exercise 3: Using Stub Functions 

What are Stub Functions? 

CoverageMaster winAMSôs Stub Feature 

func() sub() 

func()  

{  

   switch( sub() )  

   {  

     case 1:  

      :  

       :  

       :  

   }  

}  

func()  

{  

   switch( sub() )  

   {  

     case 1:  

      :  

       :  

       :  

   }  

}  

×  

STUB() 

STUB() 
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In Exercise 3 weôll be testing func3() found in the sample code. The I/O variables are as follows: 
 
      Input Variables: enable, mode (function parameters)  
      Output Variables: gb_result.data, gb_result.ret_code (also a global structure member) 

 
Within this function there is a call to another function, func3_sub_read_io(). The return value of 
the called function is temporarily stored in the local variable retval that is then used as a switch 
statement condition. In order to get 100% C0 coverage for func3(), the return value must be 
modified to enter each case of the switch statement. 
 
For this exercise, we will create a stub function for this calling function func3_sub_read_io() and design the 
stub function so that the return value can be set in the input CSV file in order to freely change the return 
value during testing. 

 

 
 
 

Now to create a stub function for func3_sub_read_io() using CoverageMaster winAMSôs stub 
feature. 

 
1. Click the Stub Settings button in SSTManager. 

 
 

  

Confirmation of stub target function 

Stub Function Creation and Settings 

int func3_sub_read_io( int index )  

{  

    // Return value depends on data é 

    if( data_table[index]>0x7f )  

    {  

        return data_table[index];  

    }  

    else  

    {  

        return - data_table[index];  

    }     

}  

 

void func3( int enable , int mode )  

{  

    int retval;  

     

    if( enable  )  

    {  

// Create a stub function an é 

retval  = func3_sub_read_io( mode );  

         

        // Branching with return value  

        switch( retval  )  

        {  

            case 0:  

                gb_result.data  = 0;  

                break;  

            case 1:  

                gb_result.data  = 50;  

                break;  

            case 2:  

                gb_result.data  = 100;  

                break;  

            default:  

                gb_result.data  = - 1;  

        }  

        gb_result.ret_code  = TRUE;  

    }  

    else  

    {  

        gb_result.data  = 0;  

        gb_result.ret_code  = FALSE;  

    }  

}  
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First letôs discuss the settings. The Stub Function Prefix at the very top is the name that will 
appear before the stub function. For this exercise we will use the default of AMSTB_ as the prefix 
so the stub function name will be AMSTB_func3_sub_read_io(). 
 
The Stub Function Source File specifies the filename the stub function will be saved in. If the 
path doesnôt match the image shown above, click the é button and change the path to 
C:¥winAMS_CM1¥UnitTest. The stub function source file AMSTB_SrcFile.c will now be saved 
in that directory. 
 
Now letôs create the stub function. 

 
2. Select func3_sub_read_io() and click the Create Stub with I/O button. 

 
A stub function template for the function selected will be created with the specified name and then 
opened for editing. 
This stub function is automatically generated as a stub declaring variables usable with INPUT / 
OUTPUT of CSV file. 

 
 

Later we will add the static variable defined in the stub function (AMIN_return) to the INPUT list 
so we can enter test data values for it. 
 
Only variables that have their addresses defined prior to the functionôs execution may be entered 
in CoverageMaster winAMS CSV files. This is why we defined the variable as static, to force the 
linker to allocate an address for the variable. 
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Now, incorporate this stub function, build with your compiler (development environment), and 
create an executable object file. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The object file ñSAMP1.outò has now been created with the stub function added. 
 
 

     
     

Next letôs create a CSV file and enter test data for func3() like we did for the previous exercises. 
First identify the input and output variables.  

 
Input: int enable, int mode, AMIN_return 
Output: gb_result.data, gb_result.ret_code 

 
1. Click the Create CSV button toward the top of SSTManager. 
2. Select Unit Test CSV and click OK. 
3. Filename: func3_data, Function: func3. 
4. Add the I/O to the INPUT & OUTPUT lists as shown below. 

 
 
 

 
 

Compile the Stub Function 

Create func3() Test Data 

 

 

 

 irq.c  

main.c 
 

 
AMSTB_SrcFile.c 

 

 

 irq.o  

main.o 

AMSTB_SrcFile.o 

 

Linker 

Compiler 

ƴ Source files with built-in stub functions 

AMSTB_SrcFile.c has a compile switch 
(WINAMS_STUB), so please specify the following 
(example) compile options. 
 
(e.g.) -DWINAMS_STUB 

ƴSample Source Files 

SAMP1.out 

 

ƴExecutable object file 
Stub functions are built in. 
Debugging information must be included. 
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5. Click the OK button to create the CSV file. 
6. Switch to the Test Settings view and open func3_data.csv in EXCEL. 

 
 

The 3rd variable, AMSTB_SrcFile.c/AMSTB_func3_sub_read_io@AMIN_return, is the stub 
functions return value we setup. Using this variable, we can choose what values will be returned 
by the subfunction. 

 
The function parameter @mode in the original function is used to pass data to the called 
function. However, since we replaced the called function with a stub function, this function 
parameter will not actually be used and thus is optional for this test example. 
 
ô111ô is entered as the value for test data cells that have no impact on the result of the test. The 
actual value does not matter and was chosen arbitrarily. 

 
As you become more familiar with unit testing youôll learn to differentiate between test data that 
impacts the result and those that do not. This will lead to the ability to create efficient test routines 
that require fewer sets of test data to obtain 100% coverage. 
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Now to test func3() using the stub function and test data we created first we must tell 
CoverageMaster winAMS to use the stub function to replace the subfunction. 

 
1. Go to the Stub Settings screen of SSTManager. 
2. Check the Replace box for stub function func3_sub_read_io.  
3. Got to the Test Settings screen of SSTManager. 
4. Select func3_data.csv. (Selection of func2_data.csv must be OFF) 

 
Start the test. 

 
5. Click the Start Simulator button. 

 
 

 

 
 
 
 
 
 
 
 
 
 
Once the testing has been successfully completed click the Coverage button to go to the 
coverage screen. 
 
AMSTB_func3_sub_read_io should appear in the Subfunction List portion of the function list. 
The subfunction list displays subfunctions and/or stub functions called by the test function. This is 
a convenient way for confirming that the stub function was properly called. 
 

 

 
 

Now switching to the Test Results screen, opening the test results CSV file should reveal the 
following results:  
 
 
 
 
 
 
 
 

 
 
 

This concludes Exercise 3, using stub functions.  
  

Testing using Stub Functions 

System Simulator  SSTManager  

Go Button  

(If not using the Auto 
Start/Quit settings)  
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In the previously 3 exercises we began by identifying the input and output variables, and then 
created test data for the unit test ourselves. In this exercise we will discuss a method to 
automatically create the test data. 
 
When testing to see that the source code matches with the functionôs specifications, test data 
should be created by looking at the functionôs specifications rather than the code itself. This method 
is referred to as ñblack boxò since you create test data without looking at the code inside ñthe boxò. 
ñWhite boxò on the other hand refers to creating test data while looking at the source code. 
 
Thorough unit testing should also include testing for robustness such that errors are not caused by 
exceptional conditions. In addition, coverage testing is important to help detect ñdead codeò not 
actually necessary for the application. These verification factors are all important in finding latent 
bugs and improving software quality. 

 

 
 

CoverageMaster winAMS can be linked with GAIOôs CasePlayer2 analysis tool to add the 
following functionalities:  

 

Â Automatically identify test input / output variables 
By analyzing the target function with CasePlayer2, the I/O variables may be 
automatically detected. This is a particularly useful feature for projects with a large 
number and variety of variables.  

 
Â Create test data to satisfy C1 Coverage 

Through the use of CasePlayer2 the test data to satisfy the C1 coverage test can be 
automatically generated. By using CasePlayer2ôs analysis data, CoverageMaster 
winAMS can automatically detect the conditional statements (if, switch, etc.) for the 
function, then create test data to execute each condition of the conditional statements 
(including nests). 

 
Â Create test data to satisfy MCDC Coverage 

Similar to C1 coverage above, CasePlayer2 can also be used to create test data to 
satisfy MCDC coverage.  

 
This type of testing is best suited for testing for dead code, unnecessary conditionals, and bugs in 
the C source file. 
 
  

  

C1 / MCDC Coverage - Test Data Creation Feature 

Exercise 4 

 
Function 
Design 

Match? 

base(int a, int b, int c) 

{ 

    if (a == 1) 

  { 

    if (b == 1) 

    { 

      idx = 0;    // data[0]  

      if (c == 1) 

         pos = 0;   // data[0].str[0]  

     

     

  } 

  //  

  data[idx].c = data[idx].str[pos]; 

  value = data[idx].str[pos]; //-  1; 

Black Box (test for 
accurate functionality) 

base(int a, int b, int c) 

{ 

    if (a == 1) 

  { 

    if (b == 1) 

    { 

      idx = 0;    // data[0]  

      if (c == 1) 

         pos = 0;   // 

data[0].str[0] 

     

     

  } 

  //  

  data[idx].c = data[idx].str[pos]; 

White Box (test for bugs in 

the code) 

Robustness 

No divisions by 0, 
overflows, or 
other defects. 

 

Coverage 

Detect dead code, 
paths, infinite loops, 

etc. 

 



 

 
CoverageMaster winAMS Tutorial 

 

 
 

-  48  -  

CasePlayer2 is a reverse CASE tool that can make flowcharts, module structure charts, and a 
variety of other specification documents by means of a source code analyzer. CasePlayer2 can 
also be used to create lists of global variables accessed by the function, look up variable references 
and assignments, and more when linked with CoverageMaster winAMS. 
 
The CasePlayer2 to CoverageMaster winAMS linked relationship is outlined below. 

 
 

 
 
 

In Exercise 4 weôre going to make use of CasePlayer2ôs capabilities to create C1 test data for the 
target function. 

 
  

Linking with CasePlayer2 

Flowchart 
(created by 

CasePlayer2) 

Variable 
Analysis 

Results 

CoverageMaster winAMS  

(SSTManager)  

Insert 
Data 

Analyze the variables Automatic Data Creation Function 

Code 

 

Create Test 
Data for 

C1/MCDC 
coverage. 

Create a variety 
of charts 
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In this exercise, weôll discuss how to automatically create test data for a C0/C1 coverage test with 
the help of GAIOôs CasePlayer2. Weôll be testing func4() (shown below), with our goal being to 
obtain 100% C0/C1 coverage.  
 
As you can see in the code below, func4() includes definitions for many global variables. Using 
CasePlayer2, first weôll identify only the global variables actually used in the function.  

 

 
 
 

We must first create a CasePlayer2 project in order to analyze the source code. 
 

1. Launch CasePlayer2 by selecting: Windows Start -> GAIO CasePlayer2 -> 
CaseViewer.exe  

2. Create a project by selecting: File -> New -> Project 
  Project Name: òCP2Projectò, Save Location: òC:¥winAMS_CM1ò, Language 
Settings -> C Source: ANSI-C 

3. Since we wonôt be using any of the other settings at this time you may leave them at 
their default values. 
 

 
 
 
 
 

 

Exercise 4: Auto Generate Test Data with CasePlayer2 

CasePlayer2 Function Analysis 

int gb_input;  

int gb_output;  

int gb_valA;  

int gb_valB;  

int gb_valC;  

int gb_valD;  

int  gb_a, gb_b, gb_c, gb_d, gb_out;  

char gb_unused1, gb_unused2;  

 

int func4( int code )  

{  

    int return_value=FALSE;     

    int i;  

 

    if( gb_a > 10 )  

    {  

        if( gb_b > 20 && gb_c > 30 )  

        {  

            gb_out = 0;  

        }  

        else  

        {  

            gb_out = - 1;  

        }  

        return_value = FALSE;  

    }  

    else  

    {  

        switch( code )  

        {  

            case 1:  

                gb_out = 1;  

                break;  

 

            case 2:  

                gb_out = 2;  

                break;  

            case 3:  

                gb_out = 3;  

                break;  

            default:  

                gb_out = - 1;  

                break;     

        }  

        return_value = FALSE;  

    }  

  

// When there are dynamically changing é 

// When the static analysis function of é 

    if( gb_d == gb_out )  

    {  

        gb_out = 4;  

    }  

    else  

    {  

        gb_out = 5;  

    }  

 

    return return_value;  

}  
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In addition, select the MPU and compiler type used. 

     
4. Select MPU and Compiler in the MPU and Compiler Specific Setting View. 

The settings should be the same as the MPU and Compiler settings in the Create 
New Project dialog of the Coverage Master winAMS. 
 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

These settings are used for setting MPU and compiler specific analysis settings. CasePlayer2 
cannot analyze compiler specific descriptions and will result in an analysis error if the proper 
analysis settings have not been set. For this purpose, CasePlayer2 has a C source code analysis 
customization feature called ñC option parametersò. By selecting the MPU and compiler type, 
common ñC option parametersò settings used by that device will be automatically set. 
 
This setting is not required when testing the tutorial sample code. However, this setting is 
recommended when testing user code so the feature is introduced here. 
 
[NOTE] For more information, refer to the ñC Option Parameterò section further down in this chapter. 
 

Coverage Master winAMS settings 

CasePlayer2 settings 

Set up the same 
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Next select the source code to be analyzed. Since all test functions are included in main.c for these 
exercises we only need to select that file. 
 

5. Click the right mouse button on CP2Project in the project tree. 
6. Select Add Source File to Project ï> by Fileé 

 

 

 

 

 

 

 

 

 

 

 

 

7. Select main.c (C:¥winAMS_CM1¥target¥main.c) and click the Open button to add the 
source file to the CasePlayer2 project. 
 

  

 

 

 

 

 

 

 

 

 

 

 

 
 
 

 

Before performing a static analysis of the target function func4(), letôs check the CasePlayer2 
settings. 
 
First, confirm the basic settings to use with CoverageMaster winAMS. 
 

1. In the CasePlayer2 Settings tab double-click Analysis Settings. 
2. Enable the following options in the Advanced Mode settings group. 

 
 ̧ Enable advanced mode 
 ̧ #define List 
 ̧ Create WinAMS analysis data 

 
These three options must be enabled to use with CoverageMaster winAMS. Other options are 
settings for program document creation and can be enabled as needed. In order to create the 
global variable reference information for the Module Specification document mentioned later, add 
to enable the following options enclosed by the dashed line. 
 

 ̧ Reference Global Variable List 
 ̧ Assignment Global Variable List 

CasePlayer2 Setting #1: Analysis Settings 
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 ̧ Local Variable List 
 ̧ Sub Routine List 

 
3. Press OK to close the dialog.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Next, letôs confirm the preprocessor settings to handle header files and #define parameters. 
 

1. Double-click on ñPreprocessorò in the CasePlayer2 Settings tab. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

CasePlayer2 Setting #2: Preprocessor 
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In order to analyze source code that includes header files, preprocessor settings configured 
in the IDE must be set in CasePlayer2 as well. These includes #define definitions and include 
path information. 
 

#define (symbol [=value]) 
Define macros should be specified here. After entering an item click the Add button or press 
CTRL + ENTER in order to go to a new line to add additional items. 
 
#undef (Symbol) 
Existing #define macros may be undefined by entering them here. 
 
Pre-Include File 
Enter a header file here in order to include it before other source files. A pre-include file that 
describes implicit definitions may be entered in order to avoid CasePlayer2 analysis errors when 
the cross compiler has implicit key words or definitions. 
 
System Include Path / User Include Path 
Enter system include paths or user include paths in these fields. The paths may be selected 
using the tree view to the right then clicking the Add button. Since Subfolders are not included, 
each folder must be specified individually. 

 

 

 

C-option parameters may need to be set in order to avoid analysis errors caused by 
incompatibilities in the code with the ANSI-C standard. CasePlayer2 analyzes C source code 
according to the selected language mode (ANSI-C / GNU-C / C99). However, CasePlayer2 does 
not recognize (reports as error) cross compiler specific code such as #pragma or language 
extensions. 
 
By setting analysis methods to the C option parameter, incompatible descriptions in the code can 
be analyzed without source code modification. 
 
Commonly used keywords will be automatically set in the C Option Parameter settings by selecting 
the MPU and compiler type when creating the CasePlayer2 project. Additional settings can be 
added manually as follows: 
 

1. Double-click on C Option Parameters in the Settings tab. 
 

   
 

 

CasePlayer2 Setting #3: C Option Parameters 
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User Keyword 

ANSI-C incompatibilities or compiler specific keywords may be added here. The 
following examples are typical settings to avoid analysis errors: 
 
Example #1: int near p1; 

Using the TYPEATT class for the near keyword will cause near keywords to 
be analyzed as a type instruction modifier. 
Keyword: near, Class: TYPEATT, Postfix Notation: [**leave blank**] 
 

Example #2: direct int array[100]; 
Using the STRAGE class for the direct keyword will cause the direct keyword 
to be analyzed as a storage class instruction modifier. 
Keyword: direct, Class: STRAGE, Postposition statement: [**leave blank**] 
 

Example #3: __asm (ñ ....... ñ) 
Using the ASM class for the __asm keyword will cause the __asm keyword to 
be analyzed as an inline assembler description. 
Keyword: __asm, Class: ASM, Postposition statement: (EXPRESSION) 
 

Example #4: __except ( ....... ) 
Using the IGNORE class for the __except keyword will cause the __except 
keyword to be ignored during analysis. 
Keyword: __except, Class: IGNORE, Postposition statement: (EXPRESSION) 
 

Example #5: INT32 val; 
Using the TYPE Class for the INT32 keyword will cause the INT32 keyword to 
be analyzed as a type definition. 
Keyword: INT32,  Class: TYPE, Postposition statement: [**leave blank**] 

 
Replacement Keyword 

Use to replace keywords in the code. 
 
Example #1: typedef  __WCHAR_T_TYPE__  _Wchart; 

__WCHAR_T_TYPE__ can be replaced by int in order to avoid errors. 
New Keyword: int, Existing Keyword: __WCHAR_T_TYPE__ 
 

Example #2: typedef  __SIZE_T_TYPE__  _Sizet; 
__SIZE_T_TYPE__ can be replaced by int in order to avoid errors. 
New Keyword: int, Existing Keyword: __SIZE_T_TYPE__ 

 
Other Settings in C Option Parameter 

Most errors can be fixed using the above described User Keywords and Replacement 
Keywords. Additional settings found in C Option Parameter include: 
  

Non-extracted Comment 
Module Specification comment extraction 
Structure Specification comment extraction 
#pragma Definition 

  

(Ref) C Option Parameter Manual Setting 
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Next perform the code analysis / program document creation. 
 

1. Select Project -> Create documents from the CasePlayer2 (CaseViewer) menu. 
The following will appear in the message view at the bottom of the CaseViewer 
window.  

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Now that the analysis and program document creation has been completed, letôs view some of the 
program documents that were created.  

 
2. Click the File tab (lower-left part of the screen) to return to the CP2Project tree. 
3. From the Documents folder select Flowchart. 
4. From the list of flowcharts that appear to the right, double-click on func4. 

 

 
 

The flowchart displayed is for func4(), the target function for this exercise. Flowcharts are 
particularly useful for visualizing condition statements (included nests) of the code. Flowcharts are 
but one of the numerous types of specification documents creatable using CasePlayer2. 
 
Next letôs take a look at a Module Specification. 

 
5. From the Documents folder select Module Specification. 
6. From the list of module specifications that appear to the right, double-click on func4. 

 
The Module Specification displayed contains information obtained by CasePlayer2 about func4(). 
 

Execute code analysis and program document creation 

message view 
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A list of global variables referenced and assigned within func4() is included in the module 
specification (as shown below). Now we can use this information for our test conditions in 
CoverageMaster winAMS. If the reference information is not be displayed, go back to Analysis 
Settings and check the necessary options. 
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Now letôs return to SSTManager (CoverageMaster winAMS) and make C1 test data for func4(). 
The analysis data should have already been imported from CasePlayer2. First letôs verify the 
analysis data file is configured correctly. 

 
1. From the SSTManager menu select: File -> Project Settings. 
2. From the Test Project Settings dialog that is displayed, check that the CasePlayer2 

Project File is set to: C:¥winAMS_CM1¥CP2Project¥CP2Project.vproj 
(if not, click the é button and select the file located in the above path). 

3. Click the OK button. 
 

After confirming that the appropriate file has been selected we are now ready to use the 
CasePlayer2 analysis data. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

* Preparation 
************************************************************************************************************** 
Please carry out below settings before creating Test CSV file. 

 
In order to use the "ATD Editor" in this tutorial the following setting is required. 

 
To use the "ATD editor", in the SST Manager go to [Tools] --> [Test Data Analysis Editor Settings] 
and uncheck the "Use the test data analysis editor for unit test CSV file data entry" checkbox in 
the "Test Data Analysis editor settings window. 
 
 
 
 
 
 
 
 
 
************************************************************************************************************** 
 
Now we are ready to create the test CSV file for func4(). The method for creation is the same as 
the previous exercises. 

 
 

CasePlayer2 linked to Coverage Master winAMS 

Select Variables from the Analysis Results 

uncheck 
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1. From SSTManager click the Create CSV button, select Unit Test CSV. 
2. Filename: func4_data, Function: func4, Test Description: (optional) 
3. From the variable list select the Detected Variables tab. 

 
The Detected Variables tab is only available when CasePlayer2 analysis data is present. Using 
the data collected during the CasePlayer2 analysis this tab contains a list of variables referenced 
or assigned by func4(). 

 

  
 

In order to test function func4(), it is necessary to input values into the global variables referenced 
by func4(). In order to do so, we will add the variables shown in the Input Variables folder to the 
INPUT list. Likewise add the Output Variables and Function Return to the OUTPUT list. 

 
In the previous exercises, since the test functions did not contain very many variables we simply 
selected the appropriate ones ourselves. For functions with a large number of variables detection 
of variables using CasePlayer2 analysis information can be very useful. 

 
Now letôs add the variables to the INPUT & OUTPUT lists. Starting with the INPUT list: 

 
4. From the Function Parameter folder add func4@code to the INPUT list. 
5. From the Input Variables folder add the 5 variables: gb_a, gb_b, gb_c, gb_d, gb_out 

to the INPUT list.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

      
Now for the OUTPUT list. 
 

6. From the Output Variables folder add gb_out to the OUTPUT list. 
7. From the Function Return folder add func4@@ to the OUTPUT list. 

<- Global variables 
assigned by func4(). 

<- Global variables 
referenced by func4(). 
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Weôve now finished setting up the INPUT & OUTPUT lists for func4(). Notice that we added gb_out 
to both the INPUT and the OUTPUT list. Using a CasePlayer2 search feature letôs check how this 
variable is being used in the source code. 
 

8. Right-click on gb_out in the INPUT list and select Open Source Code [Variable] from 
the right-click menu. 

 
The source file will be opened in the CasePlayer2 editor and go to the first line where gb_out is 
used. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

The cursor 
moves to the 
appropriate 

line. 
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Checking the usage of gb_out variables in order from this position down, there is a process that 
save constant values (Figure A below) inside if and switch statements. In the subsequent if 
statement ñif( gb_d == gb_out )ò (Figure B below), it is referenced for comparison with the other 
external variable gb_d. This is why gb_out appears in both input and output variables in the 

analysis results of CasePlaye 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Although the variable gb_out is an external variable, there is no need to add it to the test input 
condition because its value is determined by the processing within func4(). This time, gb_out is 
excluded from the input condition. (Even for variables determined inside a function, some test 
guidelines may require that an initial value always be provided to ensure that there is no execution 
path with no value set). 

 
9. Select gb_out from the INPUT list and click the Delete button. 

(gb_out will be removed from the INPUT list only). 
 

A : Save to variable gb_out 
 

B : Refer to variable gb_out 
 



 

 
CoverageMaster winAMS Tutorial 

 

 
 

-  61  -  

 
 
 
 
 
 
 
 
 
 
 
 

Weôve now finished setting up the input / output variables. Next weôre going to make test data for 
the C1 coverage test. 

 
10. Click the Enter Data button lined up on the bottom row. 

 
 

Upon clicking the Enter Data button the Unassigned I/O dialog will be displayed. This dialog 
appears as a confirmation when input/output variables detected have not been added to the INPUT 
or OUTPUT list. In this case it is warning us that gb_out has not been added (the item we recently 
removed). In order to prevent the dialog from appearing you may check Ignore box next to the 
variable. 

 
11. Check Ignore for gb_out in the Unassigned I/O dialog. 
12. Click the OK button to create the CSV file. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Press the ñXò button on the caption bar to close ATDEditor and confirm that the CSV file has been 
created. 
 
On the next page, open ATDEditor again and design test data to meet C1 coverage. 
 

 
 

Check. 
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Exit ATDEditor by 
pressing the ñXò button. 

CSV file created 
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Next, use the automatic generation feature to generate test cases that satisfy C1 coverage in the 
created CSV file. 

 
1. Select func4_data.csv in the CSV List in the Test Setting screen. 
 
 
 
 
 
 
 
 

       
The ATDEditor opens. This is an editor that after designing test data for each variable, generates 
a combination of data for each variable and outputs the test data to the CSV test input file. There 
are several windows in the ATDEditor, but we will use the "Edit Test Data" window. 

 
* What to do if the ATDEditor does not open and the Test Data Analysis Editor opens instead: 
From the ñToolsò menu, select "Test Data Analysis Editor Settingséò. In the ñTest Data Analysis 
Editor Settingsò, uncheck the "Use the test data analysis editor for unit test CSV file data entry" 
check box, then re-create the test CSV. For details on the Test Data Analysis Editor, refer to 
ñ[Application] Creating Test Cases by Test Data Analysisò located later in this tutorial. 

 
 
 
 
 
 
 
 
 

2. Start the test data editor (ATDEditor) by clicking the Edit Dataé button on the right 
side of the screen. 

 
3. From ATDEditorôs menu click Window -> Edit Test Data.  

(If the Edit Test Data window is not in the list, make sure that Edit Test Data Window is 
checked in the View menu). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Set Data for C1 Coverage 

uncheck 

Checked 
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There are 4 modes in the ATDEditor that can be selected from the pull-down menu in the upper-
right portion of the screen. 

 

 
 

The 4 modes are as follows:  
 
Â C1 Mode: for creating C1 (branch) coverage data. 

ü Using CasePlayer2 analysis data automatically create test data to fulfill C1 
coverage. 

ü Automatically create test data for each conditional statement. 
ü For maximum efficiency the minimum number of required test data sets will be 

generated.  
 

Â MC/DC Mode: for creating MC/DC (modified condition/decision coverage) data. 
ü Same as C1 mode but for MC/DC testing. 

 
Â Manual Mode: for manually creating data coverage data. 

ü Does not require CasePlayer2. 
ü Manually set the data for each variable. 
ü Data combinationsô ñbase valuesò are assigned based on a ñdecision tableò. The 

decision table will be explained later in this document. 
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Â Single Line Mode: for creating 1 line worth of CSV test data. 

ü Assigning 1 value to each variable. 
ü Can simply create 1 set of test data without having to worry about combinations.  

 
The mode may be changed in order to create test data using different modes if desired, but for this 
exercise we will only use the C1 mode. 

 
4. From the pull-down menu in the upper-right change the mode to C1 Mode. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

In this view the branches of the condition statements for func4() are listed. C1 coverage requires 
that each branch of every condition statement be executed. For example, for an if statement both 
T/F must be executed, and for a switch statement each case must be executed. 

 
This view includes each condition statement shown independently regardless of its nested status 
(hierarchy) for ease of visibility and usage. For example, the 2nd condition statement, if(gb_b>20 

&& gb_c>30) , is actually nested in the True case of the first condition statement, if(gb_a >10) . 
 

 

The first thing we want to confirm is the auto generated test data. When test data values were 
detected for all branches óAllô will appear in the conditionôs Status column. In this exercise óAllô 
should appear in the status column for the top 3 conditions.  

 
The last condition, ñif(gb_d == gb_out)ò, is blank because since the value of gb_out is determined 
during runtime, test values were not auto generated. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Check the Auto Generated Test Data 

 

 
Test data not generated 

Test data auto generated 
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Now weôre going to specify the data for the last conditional statement, ñif( gb_d == gb_out )ò. This 
conditional statement is comparing the global variables gb_d and gb_out. gb_out is assigned a 
value from within the function so we need to input values for gb_d that will fulfill C1 coverage 
requirements. 

 
The values for gb_out in the switch statement are as follows: ñcase 1: gb_out=1ò, ñcase 2: 
gb_out=2ò, etc. Therefore, if we simply set gb_d to 1, case 1 of the switch statement will result as 
true, and case 2 will result as false thereby fulfilling the C1 coverage requirements. 
 
Now letôs set gb_d to be constantly 1. 

 
1. Select the ñif( gb_d == gb_out )ò conditional statement. (Figure A below) 
2. Select gb_d from the variable list. (Figure B below) 
3. In the Test Data Settings region click the Add button, then input a 1 into the Value 

box. (Figure C below) 
- You can now type in the ñValueò and ñCommentò fields, and a line will be added to the list. 

4. Check the Value box for the recently add 1 value. (Figure D below) 

5. Check the Set Base Value box for the recently add 1 value. (Figure E below) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Weôve now completed the settings for the conditional statements. 
 
 
 
 
 
 
 
 
 
 

  

Manual Settings 

A 

B 
D 

C 

E
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Step 7 above (where we checked the base value box) is a part of the method for creating data 
combinations using a decision table. When creating combinations consisting of multiple elements, 
a decision table is used as a method for creating only the combinations that are necessary, rather 
than every possible combination. 
 
For example, suppose a function contains the variables a, b, c and we assign the following test 
values: a = 9, 10, 11; b = 19, 20, 21; c= 30, 31. Using these values we will input data combinations 
into the CSV file for unit testing. But if we enter every combination possible there will be 3 x 3 x 2 
or 18 test data patterns (a relatively small number compared to many programs). 
 
If the variables a, b, c are independent of one another, it is not necessary that we input data for 
every combination possible. It is however necessary that we enter each possible value for the 
variables at least once. But since the variables are independent of one another the values of b and 
c are irrelevant when testing variable a (with values 9, 10, 11). 
 
To start with weôll define at least one value as the base value. Using the same example variables 
weôve selected the values in brackets ó[]ô as the base values. 

 

 
 

Using the decision table combinations will be created as follows: 
 

ü For variable aôs data (9, 10, 11) the values for b and c will be the base values. 
ü For variable bôs data (19, 20, 21) the values for a and c will be the base values. 
ü For variable côs data (30, 31) the values for a and b will be the base values.  
 
The resulting test data combinations will be as follows: 
 

 
 

In Exercise 4 since we only specified one value (1) for the variable gb_d, this value will be used as 
the base value. 
 

 

Now weôre going to create test data (a CSV file) using the above settings we made.  
 
When making the settings above for the conditional statements we did not pay attention to the 
nested (hierarchy) status of the statements, but rather each as an individual condition statement. 
But some of the statements are nested, for example the second if statement, if( gb_b>20 && 

gb_c>30 ) , requires that the proceeding if statement, if( gb_a >10 ) , to be true for it to be 

tested. Thus, we need to create a test combination that satisfies these requirements. 
 

CoverageMaster winAMS uses the nest structure information provided by CasePlayer2 to 
automatically create test combinations to fulfill these requirements. For the above four  conditional 
statements the following number of test data combinations must be created:  
 
  2 (paths)  x  2 (paths)  x  4 (paths)  x  1 (path) 
 

(Ref) Decision Tables and Base Values 

Create Test Data Combinations 

a:  9  [ 10]   11      b: 19  [ 20]   21       c: [ 30]   31 

a :   9  10  11    10  10  10   10  10  

b :  20  20  20   19  20  21    20  20  

c :  30  30  30   30  30  30   30  31  

Red is the Variableôs test values 
Black is the Variableôs Base Values 
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Making a total of 16 paths to make test data combinations for. Using this information 
CoverageMaster winAMS will automatically create the minimal number of test data sets required 
to satisfy the C1 coverage. 

 
Now letôs output the test data combinations. 

 
1. From the ATDEditor menu select Edit -> Configure and Output Test Data 

Combinations. 

 
 
2. Check Donôt create duplicate test data. 
3. Check Output test data comments. 
4. Click the OK button.  

 

 
 

The test data combinations will be generated and output to the CSV file as shown in the Edit CSV 
Data window.  
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The test data combinations generated include seven test patterns. Also because we chose to 
output comments, we can see which condition statement and result the test data corresponds to. 

 
The green lines indicate comment lines. If you look at line #8 youôll notice it is the same data as 
line #3. These duplicate test data combinations are commented out because of the settings we 
made in the Test Data Combination Output Settings dialog.  

 
 
 

Now letôs save the CSV file and run the test. 
 

1. From the Edit CSV Data window click File -> Save.  
2. Click File -> Exit to close the ATDEditor.  
3. From the Save Prompt click OK to save the editor setting file (func4_data.cviv). 

 
Now weôll return to the Test Settings screen of SSTManager and prepare for testing. 

 
4. From the Test Settings screen of SSTManager check func4_data.csv (other CSV 

files should be unchecked). 
5. Under the Coverage Settings section of the Test Settings screen check Output C1 

Coverage. 
6. Click the Start Simulator button to start the simulation. 

 

 
 
 
 

From the Coverage view screen, check that both the C0 and C1 coverage rates are at 100%. We 
were able to obtain 100% coverage in this exercise simply using the seven automatically created 
test data sets. 

 

 
 

C1 Coverage Test using the Generated Test Data 

Check the Coverage for func4() 
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The Coverage view should appear as the image above. Green lines indicate full C1 coverage 
results for the highlighted branch. In the column next to the line number column (ex. Line #189) 
ñT/Fò is displayed to indicate that both true and false were executed for the if statement. If only true 
was executed it would be displayed as ñ T/ ò, ñ /Fò for only false, and ñ / ò for neither. 
  

 
 
For switch statements the number of cases executed will be displayed as # executed / total #. In 
this example, all 4 cases were executed so ñ4/4ò is displayed. 
 
 

 

This concludes the CoverageMaster winAMS tutorial. In this tutorial we learned: 
 
ü Once weôve prepared a test data CSV file, the simulation itself is automated. 
ü We can automatically allocate memory for functions which include pointer variables. 
ü When testing functions that include function calls, we can replace and control the 

subfunctions using stub functions without having to modify the source code. 
ü We can automatically create test data combinations to fulfill C1 coverage through the 

help of the CasePlayer2 analysis tool.  
 

Thank you for choosing CoverageMaster winAMS. We hope that the fundamentals you have 
learned while performing these exercises will be useful to your companyôs product development. 

Conclusion 
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Technical support information for users can be found on the GAIO website. This page provides 
information for users of CoverageMaster winAMS/General. 

 

Access the following URL using the link below. 
 (To access the link from Acrobat Reader, hold down the CTRL key and click the link.) 

 
https://www.en.gaio.co.jp/eng/support/user/techpaper.html 

 
Frequently asked questions about how to use this software are included in the FAQ. The page also 
includes setup instructions, as well as information on simulator macros (scripts) for advanced users. 
This technical support information is available for all users. 

 

(Reference) Technical Support Information for Users 

How to Access 

https://www.en.gaio.co.jp/eng/support/user/techpaper.html
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[Application] Creating Test Cases by Test Data 
Analysis 

In addition to the Auto Create Test Data feature used in Exercise 4, CoverageMaster winMS (v3.7 
or newer) also includes a support feature for creating test cases based on function design 
specifications for confirming the features of a function. 
In this application manual, you will learn about the feature for efficiently creating specifications-
based test data and performing reviews using the Test Data Analysis Editor. 

 

GAIO has provided unit testing services for many years. These services consist of test design 
based on function design documents or source code supplied by the client, taking black box and 
white box into account, and evaluation and delivery of the results obtained from test execution. 
When performing this work, an I/O Analysis Table is created. This is a table containing I/O variables 
for the input/output of the function and test data values to be assigned to these variables. This is 
used to check that no test items are omitted and that the assigned values are suitable before 
creating the test cases. 
Usually when designing test cases for unit testing, the test elements required for unit testing, such 
as boundary values, maximum/minimum values and test values for each equivalence class, are 
extracted from the specifications according to predetermined design procedures. These are then 
combined when generating the test cases in such a manner that all of these items can be tested 
with no omissions. 
In Unit Test Data Analysis, our unit testing workflow has been turned into a method for 
CoverageMaster winAMS users, based on experience that GAIO has accumulated through its unit 
testing services. CoverageMaster winAMS is equipped with Test Data Analysis Editor, a support 
feature for efficiently designing test cases using this method and confirming the suitability of test 
data designed while referring to function specifications. 

 

When designing unit tests with CoverageMaster winAMS's unit test data analysis method, this 
method confirms the suitability of test input data using the Input Data Analysis Table before 
creating test cases to assign to the function. The test data assigned to each input variable of each 
test item based on the requirement specifications is compiled in a table. After confirming that the 
input data is sufficient and performing an evaluation, this data is combined with no omissions and 
test cases to be assigned to the function are generated. 
Test design for output values is performed using the Output Data Analysis Table. The output values 
that need to be acquired when executing the function (expected values) are confirmed and listed 
in this table. An evaluation is performed to confirm that the expected values for each of the 
designed input test cases are covered by the output values extracted from this Output Data 
Analysis Table. This confirms whether the test is sufficient. 

Introduction 

What Is Unit Test Data Analysis? 

Test Data Analysis Table for Reviewing and Cross-Checking Test Designs 
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Efficient Design and Evaluation of Test Cases while Referring to the Code 
Structure and Requirement Specifications 

Essentially, specifications-based tests confirm whether a function operates according to defined 
function specifications. It is therefore necessary to read and understand the document, extract the 
necessary test items from the specifications, and create test cases when designing these tests. 
However, this work requires an extremely large number of labor hours, including the procedures 
up to the design review. 
To make this work more efficient, the Test Data Analysis Editor described in this chapter provides 
support with a feature that divides the information into test analysis items based on the code 
structure information analyzed in CasePlayer2 and uses these for efficient test design. 

 

 
 

More Efficient Test Data Design Using Test Analysis Items and Automatic 
Extraction of Test Data 

The unit test data analysis feature first parses the code structure using CasePlayer2's code 
analysis feature and then automatically creates a "Test Analysis Item" field corresponding to the 
code structure in the Input Data Analysis Table. The user can evaluate the suitability of the source 
code structure by confirming whether the generated "Test Analysis Item" field meets the 
requirement specification items. It is also possible to confirm the source code from the test analysis 
items and confirm the structure in the CasePlayer2 linked to the table. 
After confirming that the code structure corresponds to the specification items, test data is 
configured to confirm detailed requirement specifications for each test analysis item. For branch 
structure components, CasePlayer2's code analysis feature is used to analyze variables and 
boundary conditions related to the branching conditions and automatically extract values such as 
boundary values, maximum and minimum values and singular values as factors for the unit test. 
The user evaluates whether it is possible to confirm the test analysis items with the automatically 
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extracted test data, and amends the data if it is excessive, insufficient or incorrect. This enables 
efficient design of test input data. 
This in turn enables efficient execution of black box testing, in which the requirement specifications 
are confirmed, and white-box testing, in which the code structure is confirmed. 

  
 

After confirming the suitability and coverage of the input test conditions in the Input Data Analysis 
Table, the test data is combined to generate test cases for the function. 
One point of concern for test designers is when creating test combinations for code branches. For 
example, when testing the case marked as [b] in the flow chart below, the following conditions are 
required in order to arrive to this branch: variable ñenableò = ñTRUEò for branch [A] and variable 
ñmodeò = ñ1" for branch [B]. If designing this test data manually, the nest structure of the conditions 
must be considered in order to arrive at the desired branch.  
Test Data Analysis Editor includes a feature that manages conditions based on the nest structure 
of the source code and the test data entered in the "Test Analysis Item" to automatically generate 
test data combinations. In the example below, the user simply enters "input = 100" as an input 
condition for testing block [b] and Test Data Analysis Editor automatically combines the branching 
conditions for this block (enable = TRUE, mode = 1) and generates them in the test cases. 
This means that the user no longer needs to design complicated combinations of conditions, 
enabling the user to quickly design test cases for the condition needed. 
 

 
  

Automatic Generation of Test Cases from the Input Data Analysis Table 


















































































































